Praktijk

Inmiddels beheers je de basisvaardigheden van het grafisch ontwer-
pen, van het ontwikkelen van het concept tot de praktische uitwer-
king van je ideeén. In de tweede helft van dit boek worden de
ontwerpgereedschappen en -technieken uitgebreid besproken. Deze
zijn van groot belang voor elk gebied waarop je |e wilt specialiseren.
Dit deel verschaft je een grondige theoretische kennis en biedt de
mogelijkheid deze kennis door middel van oefeningen in praktijk te
brengen. Geen enkele ontwerper immers kan tegenwoordig zonder
de technologische vaardigheden. Hoewel je misschien al moderne
technieken hanteert bij de productie van je werk, is het toch belang-
rijk dat je bekend raakt met de standaardtechnologieén die ontwer-
pers gebruiken.

Niettemin kunnen deze technologieén je niet helpen bij het beden-
ken van ideeén of het creéren van ontwerpen. De conceptuele,

intellectuele en formele vaardigheden die je beheerst, onderscheiden
je van andere ontwerpers. Kortom, je hebt zowel een uitstekende
theoretische kennis nodig als uitmuntende technische vaardigheden
wanneer je als ontwerper wilt werken in de ontwerpindustrie. Je bent
nog maar voor de helft op weg als je veelzeggend en vernieuwend
werk kunt maken, want daarna moet je het laten drukken, op een
scherm toveren, in drie dimensies omzetten of op meerdere browsers
laten werken, enzovoort. De zinsnede ‘ontwerpen is een strijd, maar
drukken is oorlog) beschrijft heel goed de problemen waarmee ont-
werpers te maken krijgen als ze hun ontwerp willen omzetten in een
gedrukt eindresultaat.

Module 5 introduceert de beginselen van het maken van en het
zoeken naar afbeeldingen. Ook wordt een overzicht van de belangrijk-
ste technieken en software gegeven die vandaag de dag worden

- X" INDYGEN.

gebruikt, waaronder Photoshop en InDesign. Module 6 behandelt de
verschillende aspecten van het productieproces, zoals kleurendruk,
pdf-documenten, papiersoorten en drukproeven. Module 7 gaat over
webontwerp en bespreekt de specifieke vereiste vaardigheden en
gereedschappen. In module 8 vind je een overzicht van de zeven
grote werkgebieden voor ontwerpers, zoals redactioneel ontwerp,
webontwerp en bewegende beelden. Deze ‘voorproefjes’ moeten je
een idee geven van de belangrijkste vaardigheden en eigenschappen
die je voor elk terrein nodig hebt en van de voors en tegens van
genoemde functies. Verder bevat elke module bronnen voor meer
informatie, zoals ‘De besten’ waarin enkele van de invloedrijkste pro-
fessionals op dat gebied van ontwerpen worden uitgelicht,
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Gereedschappen
en technologieen

De opkomst van digitale technologieén
betekende een revolutie voor de grafische
ontwerpindustrie. Voorheen zette de typograaf de
letters, verzorgde de drukker een proefdruk en
huurde de ontwerper een fotograaf in.
Tegenwoordig kan één persoon al die dingen op
een computer en heet dat desktop publishing

(dtp).

Dit deel bevat een inleiding op de software-
applicaties en instrumenten die vandaag de

dag het meest worden gebruikt in de grafische
ontwerpindustrie. Elke blok richt zich op een
specifieke methode, zoals fotografie of een
bepaald softwareprogramma als Photoshop. Aan
bod komen de unieke eigenschappen,
geschiedenis en terminologie van die methoden,
zodat je ze zelf verder kunt verkennen.

&= Soft focus

Subtiel gebruik van soft focus,
20als op deze foto uit de reeks
Fitting Rooms (Paskamers),
kunnen een fascinerend beeld

opleveren en de toeschouwer een

heel andere zienswijze geven.
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MODULE 5

GEREEDSCHAPPEN EN TECHNOLOGIEEN

BLOK 1

Fotografieprincipes en heeldbibliotheken

Fotografie en beeldbibliotheken zijn belangrijk

voor een ontwerper. Ook al is de ontwerper niet in fotografie
gespecialiseerd of is hij er niet bijzonder goed in, enig begrip

van deze discipline is onmisbaar: om grove verhoudingen ui
werken, een compositie te begrijpen en al

tte
s onderzoeksmethode

voor schetsen en/of digitale illustraties.

Typen fotografie
Er zijn viff globale categorieén in de fotografie en
beeldproductie die voor ontwerpers belangrijk zijn:

+ Objecten en producten

« Portretten en afbeeldingen van mensen
« Landschappen en gebouwen

« Verzamelobjecten en textuur

- Referentie en onderzoek

Bedenk wat het doel is van je ontwerp en wat je nodig
hebt voordat je aan de shoot begint. Zorg ervoor dat de
gemaakte foto’s beantwoorden aan je doelstelling en dat
je met alle aspecten van je afbeeldingen die te maken
hebben met je ontwerp, rekening hebt gehouden. Zo zijn
productafbeeldingen vaak helder en scherp, maar kunnen
landschappen en portretten verschillende stijlen hebben
en een bepaalde stemming of sfeer overbrengen.

£k Diepte Door de variatie in diepte en het perspectief
vuan .(.je toeschouwer roep deze foto sterk de sfeer op van
liffelijke aanwezigheid in het voetbalstadion.

Het gaat erom dat de kenmerken van de afbeelding
passen bij het doel. Productafbeeldingen bijvoorbeeld
zijn bijna altijd fel verlicht, scherp en helder, terwijl land-
scnappen en portretten meer stijlen kunnen hebben.

Je ontwerpen zullen beter worden als je een effec-
tieve, mooi opgebouwde foto herkent die goed combi-
neert met typografie, kleuren en andere illustraties.

Er zijn veel redenen waarom de ene foto wel tot je
verbeelding spreekt en je een andere bij wijze van
spreken niet eens opmerkt. Het helpt als een foto
scherp is, juist belicht is, geplaatst is waar hij het best tot
zijn recht komt en ook nog iets interessants toont. maar
beelden kunnen ook een uiterst expressief onderdeel
van het ontwerp uitmaken. Probeer foto's te maken die
aansluiten op de sfeer van de boodschap en bedenk dat
er grenzen zijn aan de mogelijkheden van Photoshop.

Welke camera?

Met een digitale camera of een smartphone kun je
gemakkelijk en snel kwalitatief hoogwaardige foto's
met een hoge resolutie maken. Digitale camera's en
S(jl'wartphones zijn praktisch en veelzijdig. De foto's zijn
bij een slechte belichting van betere kwaliteit. Op de
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#% Contrast Intens licht en schaduw werken
samen om een aantrekkelijke compositie te
vormen.

4@ Symmetrie Een
symmetrische compositie,

Asymmetrie
Wanneer je de kern van
de compositie buiten het
centrum plaatst, creéer
je dynamiek.

rustig en gecentreerd, kan
kalmte maar ook leegte en
verlatenheid uitstralen. De
onheilspellende dramatiek
wordt hier versterkt door een
monochroom palet.

Layers Door de omkadering en slim
gebruik van weerspiegeling, licht en donker,
krijgt deze foto extra diepte en dramatiek.




Inzoomen Inzoomen op
details kan resulteren in een
volledig andere impact en
compositie. Op deze manier
zijn in combinatie met strakke

> Compositie De
compositie van een voorwerp
is van groot belang bij de
communicatie. The Book is
gefotografeerd in allerlei
posities voordat het definitieve
beeld werd gekozen.
Onderzoek het potentieel van
je onderwerp door de lens en

typografie spannende en
intrigerende omslagen
gemaakt voor de serie The
Art of Everyday life.

maak verschillende versies

voor je je keuze bepaalt

meeste digitale camera's kun je zeer veel foto's
bewaren, terwijl je ongewenste foto's direct kunt
wissen. Veel smartphones beschikken over een uitste-
kende camera, die je altijd bij de hand hebt, met als
toegevoegde waarde dat je de foto direct kunt verzen-
den of posten op sociale media. Qua tonaliteit kan een
foto beeld echter minder geschikt zijn voor het defini-
tieve beeld.

Voor een goede foto heb je een fatsoenlike camera
nodig. Beginners moeten eigenlijk minstens een digitale
SLR-camera hebben met 6 megapixel en een
00-80mm-zoomberelk en een zoeker of beeldscherm.
Hiermee kun je fotograferen wat je ziet, kiezen waar je d.e
afbeelding wilt focussen en hoe je hem precies wilt
opbouwen. Automatische digitale camera's berekenen de
belichting, brandpuntsafstand en de instellingen van de
lensopening zonder bemoeienis van de fotograaf.
Hierdoor kun je richten en Klikken en is het resultaat nog
redelijik ook, Als je de digitale camera liever zelf instelt,
moet je wel weten hoe de camera werkt. De fotqgr‘e_aaf
heeft in dat geval meer controle en kan ongebruikelijke
en opvaliende foto's maken.

Licht en kleur, compositie en uitzoomen .
Als je fota's maakt die als illustratie moeten dienen,

moet je ervoor zorgen dat je foto zoveel mogelijk detall,
helderheid en een evenwichtige belichting heeft,
Verdere effecten kun je desgewenst nog elektronisch
of met Photoshop toevoegen, maar bij nabewerking
zijn de mogelijkheden beperkt. Een scherpe foto kun je
vervagen en daarna weer scherp maken, maar mgt een
wazige afbeelding kun je sowieso niets beginnen.
Bepaal wat je van de foto verlangt, bijvoorbeeld een
hoge kleurverzadiging, een zwart-witfoto of een se?ia.
Maak de foto altijd in kleur en maak bij de nabewerking
de varianten. Stel ook de belichting goed in: direct
sonlicht kan de foto bleek maken maar bewolking kan
het contrast tussen donker en licht weer verminderen.
De meeste camera's hebben een lichtmeter; zorg bij
het nemen van de foto dat het streepje zo dicht moge-
lijk bij het midden staat.

Een afbeelding bijsnijden is een deel van de foto
selecteren. Het wordt vaak gedaan om ongewenste
elementen uit de foto te halen (een stukje hoofd van
een onbekende bijvoorbeeld). Het is een handige
methode om overbodige informatie te verwijderen en
het beeld te versterken. Bedenk dat een scherpe,
heldere foto veelzijdig is en aangepast kan worden.
Een slechte, wazige foto kan met nabewerkingtechnie-
ken niet gecorrigeerd worden.

€ ZIE00K: DE
COMPOSITIE, P. 32

DE BASIS VAN KLEUR, !
P. 88

PHOTOSHOP, P. 110

FOTOMONTAGE EN
COLLAGE, P. 113

CETA L] b

WELKE LENS?

verschillende lenzen

vergroten de I

mogelijkheden

van de camera.

+ Een normale lens op
een digitale of analoge
SLR is 35 mm, goed h
genoeg voor het '
menselijk oog.

+ Een macrolens maakt
scherpe, extreme
close-ups.

» Een groothoeklens
heeft een breder beeld,
maar een vertekend

perspectief,
« Een telefotolens ziet
voorwerpen in de verte.

Je foto’s archiveren

Het bewaren van digitale foto's dient met zorg te
gebeuren. Het is niet voldoende om ze alleen op de
computer te bewaren. Maak een back-up op een
draagbare, externe harde schrijf, USB-sticks of brand
ze op dvd's en cd's. Als een negatief is beschadigd,
kan de folo nog steeds worden afgedrukt en geretou-
cheerd, maar met een kapotte harde schijf ben je al je
foto's meteen kwijt.

Beeldbibliotheken

Bij het beslissen welke beelden je gaat gebruiken, is
de belangrijkste overweging: is de verhouding tussen
opdrachti, tijd en beloning zodanig dat je een compleet
nieuwe afbeelding maakt of is het nodig om een kant-
en-klare afbeelding van elders te halen?

internet is de snelste manier om afbeeldingen te
zoeken, bijvoorbeeld op websites als iStockphoto en
Dreamstime. Deze kun je (zonder royalty's) kopen en
de meeste sites gebruiken een creditsysteem. Op
sommige sites bijvoorbeeld, betaal je voor een foto van
een tent 1 credit voor een afbeelding van 72 dpi, wat
acceplabel is voor een digitale foto, of 5 credits voor
een foto van 300 dpi die gebruikt kan worden voor
een te drukken illustratie.

Foto's kunnen voor een bepaalde periode of voor
onbepaalde tijd worden gekocht. Een nadeel van een
liidelijke aanschaf is echter dat je nooit weet of andere
ontwerpers niet dezelfde foto's in hun werk zullen
gebruiken. Je klant kan willen dat je de foto voor onbe~
paalde tijd aanschaft, wat beslist meer geld zal kosten.
Het aanpassen van een afbeelding is altijd de beste
creatieve optie. Je kunt de elementen die je nodig hebt
selecteren en je eigen afbeelding creéren door een
collage te maken of te retoucheren zodat de bestaande

afbeelding bij je project aansluit.

Diepte Door scherpe
lijnen af te wisselen met soft
focus kun je de aandacht
richten op een belangrijk
element van de foto en
tegelijk een bepaalde sfeer
oproepen, die uitnodigt tot
een andere zienswijze.
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TIPS EN BEGRIPPEN

Neem de tijd om je instellingen te
controleren. Stel je f-stops bij als je
meerdere versies maakt,

» Scherpte-diepte: afstand tussen het
object en waar de focus wazig begint
te worden. Een fotograaf bijvoorbeeld
kan een product scherp willen en de
achtergrond wazig. Hij zou dan een
kleinere lensopening (f22) kiezen,
een tragere filmsnelheid (1ISO 100)
voor een hogere resolutie en extra
belichting en externe flits instellen.
F-stop/lensopening: de grootte van
de lensopening ot ‘iris' in een camera,
die de hoeveelheid licht die de film of
pixelsensor bepaalt. De reikwijdte op
een gewone camera is f4 (grote
lensopening) tot 122 (kleine
lensopening). Met een grote
lensopening (bijvoorbeeld f2) komt er
meer licht in de camera, wat

resulteert in een zachtere

atbeelding; een kieine lensopening
(f16) laat minder licht in de camera
binnen, maar geeft een scherpere

atbeelding.

* Filter: glazen of plastic platen die

aan de voorkant van de lens zijn
bevestigd om verschillende

kenmerken te kunnen benadrukken,
Bijvoorbeeld, een polariserende filter

vermindert de lichtstraal, en een
kleurfilter versterkt verschillende
kleuren. De term filter wordt ook
gebruikt voor het bewerken van

foto's met diverse software-apps en

voor sociale media.

* SLR: Single Lens Reflex. Dit soort

camera's hebben een zoeker en

spiegels, zodat de fotograaf door de
hootdlens kijkt en een 'wat je ziet, is

wat je krijgt'-foto het resultaat is.

FPO: For Position Only. Het gebruik van een
tijdelijke afbeelding of afbeelding met lage
resolutie in plaats van de kwalitatief goede
afbeelding tijdens het ontwerpproces.

180: Interational Crganization for
Standardization. Oeze heeft de standaard-
norm voor virtuele filmsnelheden in digitale
camera’s gesteld: ISO 100, bijvoorbeeld,
werkt het best bij een goede belichting voor
stilstaande objecten; ISO 1600 werkt het
best bij een slechte belichting en voor bewe-
gende beelden,

Resolutie: de output in het resultaat van
een digitale camera. Digitale camera’s en de
beste mobigle telefoons hebben een 12
megapixel sensor. De fotc’s die je hiermee
maakt zijn minder korrelig en van goede
kwaliteit door de foto's korrelig en kwalita-
tief slecht zijn.

105




106 DEEL 2 PRANIIIC MODULE 5 GEREEDSCHAPFEN EN TECHNDLOGIEEN

DEEL 2 PRAKTIJK
MODULE 5 GEREEDSCHAPPEN EN TECHNOLOGIEEN
sLok2 | Opmaakprogramma’s

Als je werkt met opmaakprogramma’s breng je
alles wat je hebt geleerd omtrent compositie, paginalay-out,
contrast en typografie, in praktijk. Met deze programma’s breng
je de elementen die je hebt gecreéerd met vectorsoftware en
de afbeeldingen die je in rastersoftware hebt aangepast samen
met de inhoud. Je kunt met behulp van deze programma’s tekst
en afbeeldingen combineren om brochures, magazines, posters,
boeken en web-pagina’s te creéren.

Adobe InDesign is het standaardopmaakprogramma voor professi-
onals. Er verschinen regelmatig updates van het programma.
Adobehestanden kunnen meestal worden geopend in elke editie
van de software, maar als je een nieuwere update van InDesign
gebruikt, die moet worden geopend in een oudere upgrade, sla dit
bestand dan eerst op als een mark-up of IDML-bestand. Er zijn
functic-overlappingen tussen Adobe lllustrator, Photoshop en
InDesign, maar het is van groot belang dat je de juiste software
gebruikt voor het juiste doel. Gebruik bijvoorbeeld voor het bewer-
ken van typografie llustrator vanwege de vectorbestanden, en
bewerk foto's in Photoshop vanwege de mogelijkheden tot pixelbe-
werking. ledereen heeft zin eigen unieke manier om deze soft-
ware-programma'’s te gebruiken; het gaat erom uit te vinden wat

het beste werkt voor jou.

1 Selecteren Met dit
gereedschap kun je de hele
vorm of lijn selecteren, die
vervolgens uitgerekt,
geroteerd of naar elders op
het canvas verplaatst kan

HANDIGE
GEREEDSCHAPPEN
EN KENMERKEN

InDesign heeft veel gereed-
schappen die bomvol met han-
digheidies en functies ztten,
die je helpen de mooiste com-
posities te maken. Hier volgen
enkele eenvoudige maar zeer
bruikbare gereedschappen die
de steunpilaren van elke
InDesigngebruiker zijn.

worden.,

Marge: de meestal lege ruimte
boven aan, onder aan en aan de
zijkant van een pagina tussen de
vitsnijdlijntjes en de printruimte.
Koppen, voetnoten en
paginanummers worden hier
geplaatst.

Rugmarge: de binnenste
marges of lege ruimte tussen
twee tegenover elkaar gelegen
pagina's. Wordt gebruikt voor
het inbinden. De hoeveelheid
rugmarge is afhankelijk van hoe
de publicatie ingebonden gaat
worden.

Snijtekens: verticale en
harizontale lijnen in de hoeken
van een afbeelding of pagina
die aangeven dat je daar moet
uitsnijden.

2 Direct selecteren
Selecteert en manipuleert
specifieke lijnen of
ankerpunten om de positie
van individuele lijnen, punten
of curven van een vorm te
wijzigen.

Werkveld

De (hoofd)menubalk bevindt zich links
op het scherm, het canvas in het
midden en de secundaire
gereedschapshalken rechts.

(Hoofd)menubalk
InDesign heeft zijn
belangrijkste
gereedschappen in ¢én
lange balk staan. Net als
veel van de functies in
Illustrator, Photoshop en
Quark, krijg je toegang
tot de gereedschappen
door op de icoontjes te
kiikken of de
sneltoetsen in te
drukken die zijn
toegewezen aan elk

gereedschap, Zo is V
Selecteren, P Tekenen
en G Verloop. Bij
sommige icoontjes staat
een pijitje. Een klik
daarop onthult andere
gereedschappen, zoals
Afronden Kaders, Vullen
en de Meetlat.

g,

3 Pen Hiermee kun je rechte of kromme lijnen
maken, Je selecteert twee punten op het
scherm en ‘buigt’ ze in de gewenste vorm. Als
je op Pen Klikt, verschijnen Ankerpunt
toevoegen, Ankerpunt Verwijderen en
Ankerpunt Omzetten, waarmee je de punten
waaruit de (kromme) lijnen bestaan, kunt
manipuleren.

|
I

Je kunt het Contiolpalet boven of onder
aan het scherm vastzetten, maar je kunt
hem ook los laten zweven

Hoofdpagina's zijn de paginasjablonen
waarop je elementen kunt programmeren,
Bijvoorbeeld roosters, koppen en voetnote
en automatische paginantmmering

i Pop-upschermen Het ordenen van je
scherm is belangrijk omdat de hoeveelheid
benodigde paletten en gereedschappen je
scherm gemakkelijk kunnen vullen. De Adobe
CC-applicaties helpen je bij het terugwinnen
van schermruimte doordat je als gebruiker

desgewenst paletten kunt vastieggen en
minimaliseren, Uit verschillende functies onder
Venster > Werkruimte, kun je een
vooringestelde ordening kiezen of je eigen =
ordening maken. Er is ook een handige reset- D:
optie voor als je een van je schermen kwijtraakt,

4 Tekst Wordt gebruikt voor het

maken van tekstkaders en het

bewerken van de letters daarin.

In combinatie met het
Conirolpalet en Letterpaletten
kun je met dit gereedschap

tekst selecteren en wijzigen. Zo

kun je koppen, alinea’s en
bijschriften maken.

¢ Info

X:186.5 mm
Y:75 mm

W:184
3 Hes
’__:j_

Controlpalet Voorziet in aan te passen
functies voor Tekst met betrekking tot de keuze
van fonts, koppen, dikte en stijl, alineabelijning,
kolommen en marges.

n

Klik op pop-
upschermen om
ze te activeren
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Kleurstalen Een kleurig icoontje
rechts van je kleurstaal geeft aan of
de kleur CMYK of RGB is.

¢ Swatches O

i ooT
P (Nane)
[Registration]

W irapun
Y=0 K=0

0 Yel K=0

0 K=l

C=100 M=80 Yn10 K=

Een kleurig icoontje
rechts van je
kleurstaal geeft aan
of de kleur CMYK
of RGB is,

Om een kleurenmix
te wijzigen — door de
numetieke waarden
of PMS-nummering
in fe vullen Kik je
tweemaal op een
staal. Dan verschijnt
de Kleurenmixer. In
deze setting kun je
ook switchen tussen
CMYK en RGB.

Standaardkleurenstalen die aan‘elk document hangen zijin Geen, of leeg,
100% wit, 100% zwart en Registratie. Deze zijn niet te bewerken in
InDesign. Meestal gebruik je gewoon 100% zwart, Registratie is zwart als
me\wgk\eur van alle vier de CMYK-kleuren voor het aangeven van registratie-
linen, de paskiuisen en snijlijnen die je druld<er zal gebruiken om verschillen-
de afdiukken op een pagina pas te krijgen en af te snijden.

6 mm
582 mm

5 Kader en Vorm Hiermee
maak je rechthoekige, veel-
hoekige en ronde vormen: met
Kader maak je kaders waarin je
grafische voorstellingen en
afbeeldingen kunt zetten; met
Vorm teken je vormen die je
kunt inkleuren of omlijnen met
Kleur. Met behulp van het palet
Transformeren kun je grootte en
positie nauwkeurig aanpassen.

Transform

2 Informatiepalet Toont informatie over de lay-out van het
document of selecteert voorwerpen zoals positiewaarden, kleur,
formaat, tekst en rotatie. Het is ter informatie; je kunt er niets
aan toevoegen of in wijzigen, maar je kunt achter veel
kenmerken van een voorwerp komen door er met je cursor
overheen te gaan.
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Paginalay-out

Bij de lay-out wordt van verschillende

Een terugkerende grafische
vormgeving kan op de Master
Pages worden ingesteld

Paginanummers en sprekende
kepregels worden op de Master
Pages ingesteld

middelen op het scherm gebruikgemaakt.
Tekstkaders en afbeeldingkaders helpen

I “

om van illustraties, inhoud en kleur een

compositie te maken op een gegenereerd

prikbord. Deze composities kunnen
virtueel gestructureerd worden in

bijvoorbeeld 2, 10 of 50 pagina's. Het

programma kan ook zaken als

paginagrootte, pagina-instelling en

afdrukken aan. De volgende

gereedschappen zijn standaard:

Richtlijnen Op verzoek kun je
denkbeeldige linialen op de pagina leggen.

Deze worden niet geprint, maar helpen je bij

het maken van lay-outs en rasters en het lijnen

van voorwerpen. De rug- en andere marges

worden meestal ingesteld in de Master Pages.

Afloopgebied

Als je afbeeldingen voorbereidt, vergeet dan
niet te compenseren voor het afloopgebied.
Als een van je afbeeldingen aan de rand van
de pagina staat, houd dan rekening met een
extra marge van 0,3175 cm of 1/8 inch die
er na het drukken afgesneden zal worden. Dit
geldt ook voor achtergrondkleuren en lijnen.

Concepten voor de paginalay-out

Behalve voor het ordenen en plaatsen van afbeeldin-
gen is dip ook uitermate geschikt om met typografie
de inhoud uit te drukken. Door het opsplitsen in en
laten doorlopen van lekst over meerdere kolommen
of pagina’s ontstaan hiérarchie en geordende infor-
matie. Een goede compositie en tekstlay-out verkrijg
je door eindeloos te schuiven met alles op je pagina.
Wen er maar aan! Overal maaki men bij tijdschriften
en kranten maar met één doe! gebruik van dip: om
zovee! mogelijk woorden leesbaar en esthetisch aan-
genaam op een pagina te krijgen. Rasters, lay-outs,

sjablonen en kolommen moeten daar aliemaal bij
helpen.

Met Master Pages en Style Sheets kun je bijna
elke compositie en bijna elk project maken.
Belangrijke zaken als het exporteren als pdi-bestand
en het persklaar maken van documenten, voor de
drukker bijvoorbeeld, lukken over het algemeen
prima met dtp. Je moet echter wel weten wat je
zoekt. Een goed pdfdocument of geéxporteerd
pakket moet het bijgewerkte bestand bevatten, pdf
in geval van een drukproef, een map met de afbeel-
dingen en een map met daarin alle gebruikte fonts.

aan- en uitzetten

Rasterlijnen kun je

Afloopgebied

——

Master pages Deze sjabloonpagina’s bevinden zich meestal
boven aan het palet Pagina of Paginalay-out, De sjablonen
bevatten vooringestelde pagina’s met rasterelementen,
elementen als tekstbiokken, koppen en voetnoten en
automatische paginanummering, Deze lay-outs helpen uniforme
— veranderingen in een groot document door te voeren, maar

= kunnen desgewenst per pagina worden aangepast. Je kunt een
= master page aanpassen met Command/Ctrl + Shift + klik.

Click on drop-down menu
> Override All Master
Page ltems to alter
elements on the pages
that are highlighted on
the pages menu

= s Pages Laye Sw

Click on icons to get to
Master Pages

A b [0 LI Bl

————mmIam

Thumbnails show the

100 content of each page

5 In 7 Spreads iy,

| Paginanummeting

Maak op de Master Page een Tekstkader en
ga naar Letter > Voeg Specifieck Karakter toe
> Markers — Huidig Paginanummer. In het
document wordt elke pagina nu automatisch
genummerd.

Schakels
Anders dan Photoshop en lllustrator verbindt InDesign

Pakket / package

BLOK 2: OPMAAKPROGRANMMA'S

Stijl-sheets Ontwerpstijlen en typografische stijlen, zoals
kleur, grootte, interlinie, positie en versieringen, kunnen
met Style Sheets automatisch op tekst worden toegepast.
Tekstselecties kunnen met één klik worden gemerkt met
bepaalde vooringestelde meta-informatie. Door een reeks
elementen Opschrift te noemen, kun je globaal de stijlen
en attributen van elke selectie bepaleri, Dit spaart veel tijd
als Je op het allerlaatst wijzigingen wilt aanbrengen in je
ontwerp.

Objectstijlen kunnen worden
toegewezen aan voorwerpen,
groepen en kaders, Je kunt er
de lijn, kleur, vulling, schaduw,

transparantie, tekstblokken en
meer mee wijzigen

eat Frama)

Paragraph Styles

Met Alineastijlen kun je de

algemene spatiéring, interlinie
en opmaak van een alinea of
cen reeks alinea’s aanpassen

Met Karakterstijlen kun je
geselecteerde tekstonderdelen
wijzigen, Bijvoorbeeld giootte,
dikte en cursief
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beelden uit de mappen in je computer. Als je deze
mappen verplaatst of een andere naam geeft, verdwij-
nen de links en gaat het mis bij het exporteren. Het is
daarom van het grootste belang dat je een goed geor-
ganiseerd opslagsysteem hebt: een folder voor je
beelden, een folder voor je lettertypen, enz. Is de link
verbroken, kies dan Window en Links. Je ziet dan een
Klein icoontje dat een verbroken schakel toont,

Het exporteren van documenten voor drukproeven,
vooral PDF's, en het klaarmaken van bestanden voor
de publicatie zijn zaken die je goed kunt oplossen met
een opmaakprogramma, Toch moet je weten waar ver-
kopers naar op zoek zijn. De juiste manier om tekst te
verzenden bevat de volgende elementen: het getip-
datete bestand, de PDF voor de proef, alsmede alle
hulpmiddelen en links voor het bestand, zoals een
beeldengalerij en een folder met lettertypen. Controleer

je licenties voor letlertypes en beelden vésr verzending
naar de drukker.

ZIE 00K: PHOTOSHOP,
P. 110

ILLUSTRATOR, P. 114

BESTANDEN DRUKKLAAR
MAKEN, P. 124
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gLok 3 | Photoshop

Photoshop is het standaardsoftwarepakket voor het bewerken
en manipuleren van rastergrafiecken en wordt regelmatig gebruikt voor het
selecteren van elementen voor montage of om foto’s te retoucheren, zowel
voor drukwerk als digitaal gebruik. Met Photoshop kun je ook eenvoudige
3D-modellen, animaties en diverse uitingen voor websites maken.

Photoshop vervangt en versterkt donkerekamertechnieken,
zoals retoucheren en het bewerken van helderheid en con-
trast, Uitsniiden gaat gemakkelijk en de hele bewerking kan
plaatsvinden in een schonere, ‘droge), chemicaliénvrije
omgeving. Veelgebruikte gereedschappen zijn het Penseel,
de Gum en Reparatie. Hiermee kun je tekortkomingen en
ongewenste elementen verwijderen.

Een tablet met Het grootste voordeel van Photoshop is dat geimpor-
styluspen Is favoriet bij veel teerde afbeeldingen verplaatst en bewerkt kunnen worden
designers die met Photoshop  en op een potentieel oneindig groot en gelaagd werkveld
kunnen worden gelegd zonder dat de informatie, kwaliteit of
resolutie verloren gaat. Elke grafische kunstenaar die met
Photoshop werkt, moet enige kennis hebben van de
beschikbare selectiefuncties en begrijpen hoe je opties op
elkaar kunt stapelen.

werken. De pen stelt je in
staat je hand gemakkelijk en
precies te bewegen alsof je
een kwast of penseel
gebruikt. Het populairste
tabletmerk is Wacom.

71 Rectangular Marques Tool M

HANDIGE FUNCTIES EN
EIGENSCHAPPEN

Ellipiical Margues Tool M
ngle Row Marques Tool

7 Single Column Marguaa Tool
u

Er zijn vier hoofdgereed-
schappen waarmee je een

Standaard- gereedschapsbalk
werkveld

Hier zie je de algemene
lay-out van Photoshop.

Meer pop-upmenu's Krijg je
via het Window-menu
boven aan het scherm.

Belangrijkste
functiebalk

Via icoontjes krijg je
gemakkelijk toegang
tot de belangrijkste
gereedschappen.
Sommige daarvan
kun je ook bedienen
met een snelioets.

—

Swatch Name: R=28 G155 B+216
¥ Name with Colour Valua
-

Selectie van voor-/
achtergrondkleur. Met een klik op
de vierkantjes selecteer je de
kleur, terwijl je met de X-toets
van kleur kunt wisselen

5 b -
2 . L Pan Tool
9} Freaform Pen Toal
+¢\ Add Anchor Polnt Tool

& Quick Selaction Tool W
. .’-\Magic ‘Wand Tool W

"2’" Deleta Anchor Polnt Tool
I\ Canvert Polnt Taol

Het werkgebied

PRI

g P B BRES 00/ OSEOMALE B¢ LA Ay

& Kleurbewerking De
Photoshop Kleurbewerking,
die nu op het CMYK-
systeem staat (cyaan,
magenta, geel, zwart) dat
voor kleurenprints wordt
gebruikt. De RGB-
kleurbewerker (rood, groen,
blauw) wordt gebruikt bij het
ontwerpen voor internet/
televisie. Elk systeem heeft
een ander effect op het
kleurgebruik.

{;—j ) ¢ Lasso Tool

) Magnatlc Lasso Tool

Secundaire gereedschapsbalken

SNELTOETSEN

Deze sneltoetsen zijn

Met het menu voor Kleuren kun je
de kleuren aanpassen door de

handig en tijdbesparend:

RGB- of CMYK- waarden aan te sctlof&__C
passen. Kopiéren
» clrl of €__V
Plak
cctriof @__ 7

Het pop-upmenu voor Lagen geeft Ongedaan maken

een gedetailleerd overzicht van
elke werklaag en van welke filters

of toevoegingen elke laag bevat *cirlof &__T

Vrije wijziging

* Spatiebalk +
muisbeweging: beweeg
werkveld rond. [ of 1]
maken het penseel
kieiner of groter.

Vooringestelde
kleurstalen De stalen
worden gebruikt als
standaardkleurensets,
bijvoorbeeld zwart, wit, 10%,
20% en B0% grijstinten. Als
je je eigen standaardkleuren-
staal hebt of opdracht hebt
gekregen een bepaalde set te
gebruiken, kun je die opslaan
en selecteren,

=/ Brush Tool 8
*.;-.6‘ Pencll Tool B

‘;.1.’ Color Replacemant Tool B
i‘ # Mixer Brush Tool B

geselecteerd veld pixels kunt
bewerken zonder de rest van
de foto te veranderen. Elk van
die gereedschappen bevindt
zich op de gereedschapsbalk.
Het Penseel is veelzijdig en
heeft veel mogelijkheden.

1 Selectiegereedschap Selecteert een gebied of trekt
een grens in de laag waarin wordt gewerkt. Verschillende
selectiegereedschappen kunnen rechthoeken en ovalen
selecteren en als je Shift ingedrukt houdt, kun je er
geometrische cirkels en vierkanten mee selecteren. Met
deze functie kun je ook een horizontale of verticale lijn van
één pixel breed over de hele laag selecteren. Dat is handig

2 Toverstaf Selecteert pixels van dezelfde kleur
met de Tolerantie-optie of meerdere kleuren als de
Tolerantie op meer dan 1 staat, Als Aangrenzend
niet is aangevinkt, zal hij alfe pixels in het hele
document selecteren die dezelfde kleurwaarde
hebben, ongeacht of ze aan elkaar vastzitten.
Gebruik Shift als je pixels aan de selectie wilt

3 leken- en tekstgereedschappen Creéert
richtingslijnen en -curven met richtingspunten
(e llustrator, pag. 118), Deze punten kunnen
over de laag worden gesleept om ze beter te
laten passen. Een segment dat door
Tekengereedschap is begrensd, kan met behulp
van Emmertje worden ingekleurd.

4 Lasso Tekent en selecteert met de hand gemaakte vormen.
Gebruik Shift om een nieuwe selectie toe te voegen en Alt om
een selectie te verwijderen. De Veelhoeklasso tekent
rechtlijnige segmenten. Gebruik Alt om te wisselen tussen de
Lasso en de Veelhoekiasso, en Shift om loodrechte hoeken of
hoeken van 45 graden te tekenen, De Magnetische Lasso lijnt
een vorm uil door aan de pixelhoek e blijven kleven,

5 Tekengereedschap Grootte, vorm en kleur
kunnen worden aangepast, net als de druk en
het effect. Verander de dikte of het
dekvermogen van het penseel voor
verschillende effecten bij het retoucheren,
textuur toevoegen of digitaal schilderen. De
Tekengereedschapopties staan onder F5 en

als je een gestreept paginapatroon maakt of een grens
wilt trekken,

toevoegen, en Alt als je er pixels vanaf wilt halen.

onder de menubalk bovenaan.

m
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Pixels

Pixels kun je het beste beschrijven als een klein vier-
kantje in een rooster van vierkantjes op het beeld-
scherm. Elk vierkantie wordt verlicht door verschillende
dichtheden rood, groen of blauw licht (RGB) die samen
het hele kleurengamma vormen. Deze pixels kunnen
afzonderlijk en als een groep worden bewerkt. Als ze
klein genoeg zijn, smelten ze samen tot een egale foto.
Een andere naam hiervoor is rasterafbeelding of
bitmapafbeeldingen.

= ZIE DOK:
OPMAAKPROGRAMMA'S, P. 106

Resolutie

Fotoresolutie is een belangrijk kennisgebied voor een
grafisch ontwerper. De meest gangbare maat voor resolutie
is ‘dots per inch), punties per inch, ofwel dpi. Op een foto van
25 dpi zie je de punties heel duidelijk. Bij 72 dpi (dat voor alle
digitale afbeeldingen wordt gebruikt) is hij duidelijker, maar
kwalitatief nog niet goed genoeg om af te drukken. De
standaard resolutie voor fotokwaliteit en gedrukte afbeelding-
enis 300 dpi, of voor grote posters, 600 dpi. Controleer of je
beeld op 100% schaal is, met de juiste dpi. Als je een Kiein
beeld van 300 dpi 200% vergrool, wordt het daardoor
1650dpi en wordt de kwaliteit onvoldoende. In Photoshop kun
je een beeld met hoge resolutie van bijvoorpeeld 300 dpi
makkelijk verkleinen tot een lagere resolutie van bijvoorbeeld
72 dpi, maar je kunt een beeld met een lage resolutie van
bijvoorbeeld 72 dpi niet ophogen naar 300 dpi.

26dpi 72dpi

Als je dit aanvinkt, blijven de
afmetingen van het document
hetzelfde of ‘geforceerd’

. Scannen

Eén manier om afbeeldingen te importeren in
Photoshop zodat je ze kunt bewerken en
invoegen in een ontwerp, is door ze te scannen.
Ga hiervoor naar Bestand > Importeer,
selecteer de scanner en volg de aanwijzingen.
Striptekenaars bijvoorbeeld, scannen pen- en
potloodtekeningen als lijnkunst of als
vierkleuren van 300 dpi. Deze kunnen op een
laag worden geplaatst met de Meng-optie op
Dupliceer. Daarna kunnen meerdere lagen
worden toegevoegd om accenten, middentonen
en schaduw aan te brengen met het Penseel.

De resolutie Laat zien dat de
wordt hier afmetingen van
gewijzigd afbeelding en document

hetzelfde blijven

[ 7.8M (was 2,74M)

Collage: komt van het Franse
woord voor 'lijmen’. Betreft de
samenvoeging van elementen
textuur, gevonden materiaal en
kranten.

Dpi: stippen per (vierkante) inch;
de gebruikelijke resolutiemaat.
Ontwerpers gebruiken meestal
afbeeldingen van 72 dpi voor
digitale foto’s en afbeeldingen
van 300 dpi voor fotoafdrukken.

Gelegenheidsdrukwerk:
voorwerpen zoals kranten, bus-
en treinkaartjes en ander
tijdgebonden drukwerk.

Nevenschikking: het proces
waarbij twee of meer niet-
gerelateerde of tegengestelde
elementen of voorwerpen
worden samengevoegd om
verschillende effecten te
creéren.

{Foto}montage: het proces
waarbij foto's worden
samengesteld uit stukjes van
andere foto’s.

Pixel: het kleinste element op
een computerscherm of
afgedrukte foto. Het woord
‘pixel’ is een samensmelting virn
het Engelse picture {pix-} en het
element (-el).

PPI: pixels per inch,

Raster: verzamelingen pixels op
een tweedimensionaal rooster
dat je op het computerscherm
kunt zien.

Resolutie: de helderheid var
een digitaal beeld, Een
afbeelding met een lage
resolutie (30 dpi bijvoorbeeld]
toont duidelijke de pixels; op
een afbeelding met een hoys
resolutie (300 dpi bijvoorbecid)
zie je ze niet

Werkveld: het virtuele veld
waarop afbeeldingen in

Photoshop worden geplaatst.

Lagen

Photoshop kan verschillende
afbeeldingen en elementen op elkaar
stapelen, zodat je daaraan kunt
werken zonder de rest te veranderen.
Via de menubalk Lagen rechts van
het werkveld krijg je toegang tot de
volgende opties:

Zichtbaarheid Verandert de
doorzichtigheid van elke laag.
Voorinstelling Voegt kleurstijien en
texturen aan de laag toe.

Stijlen Voegt effeclen aan de laag
toe, zoals schaduw, strepen,
glanzende randen en texturen,
Opties voor overvloeien Veranderen
de eigenschappen van de laag.

Via het hoofdmenu krijg je toegang
tot het volgende:

Laag > Verenigen/Eén laag maken
Voegt alle of enkele lagen samen.
Filter Past effecten toe, zoals
vervagen, verscherpen, belichting en
texturen,

Gebruik deze opties om de grootte,
resolutie, kleurwaarde en witbalans in
elke laag aan te passen:

Afbeelding > Aanpassen >
Kleurtoon/Verzadiging
Helderheid/Contrast
Afbeeldingsgrootte/resolutie
Canvasgrootte

Klik op een laag en houd ingedrukt
om hem te verslepen, naar voren te
halen of onder andere lagen te
plaatsen.

Elke laag heeft zijn
eigen balk

Layers Channals Paths

PR e T

Verbergt de laag
of maakt hem
zichtbaar

Laag voor
miniaturen

S O T oG

Voegt nieuwe lagen toe

Verwijdert lagen door ze
hierheen te slepen

MASKERS

Quick Mask Selecteert en vergrendelt een gedeelte
dat niet bewerkt moet worden, Selecteer met een
gereedschap naar keuze het gedeelte dat je wilt
bewerken. Selecteer vervolgens uit de menubalk links
de optie Quick Mask. Om de selectie toe te voegen,
maak je hem zwart; om hem eraf te halen, wit. Als je
de modus Standaard Bewerking kiest, toont de
selectie de wijzigingen die je in de Quick Mask
modus hebt gemaakt.

Layer Mask Creéert boven op de bestaande
afbeelding een nieuwe laag waaraan effecten kunnen
worden toegevoegd,

Channel Mask Selecteert en maskeert alle velden
met een bepaalde reeks kieuren,

Collage Met kleur, beeld, textuur en vergroting of
verkleining kun je mooie composities maken, handmatig of op
de computer: zoals dit dynamische omslagontwerp voor een
ontwerpwedstrijd.

BLOK 3: PHOTOSHOP {43

FOTOMONTAGE EN COLLAGE

Fotomontage en collage zijn eeuwenoude
artistieke methoden, waarbij elementen
van foto’s, afbeeldingen, texturen en
typografie worden samengebracht om
nieuwe betekenissen en afbeeldingen te
vormen. Fotomontage is een proces
waarbij je foto’s manipuleert. Het wordt
geassocieerd met vroegere grafische
kunstenaars als Hannah Héch en John
Heartfield, maar ook met moderne illus-
tratoren, zoals Dave McKean. In dit pro-
ces worden segmenten uitgeknipt en
opnieuw samengevoegd tot een naadloos
geheel of tot een geheel waarbij de
naden/randen zichtbaar blijven, vaak om
esthetische redenen.

Bij collages maken gaat het proces meer
om de samenstelling van verzamelabjec-
ten, texturen en typografie, wat je kunt
zien in het werk van de kunstenaars Kurt
Schwitters en Romare Bearden. Veel van
deze afbeeldingen zijn gebaseerd op
gevonden voorwerpen of materialen en
vormen uiteindelijk abstracte collecties
en patronen waarbij de nadruk meer ligt
op de textuur en esthetische kwaliteiten
dan op het overbrengen van een bepaal-
de boodschap.

THE BIG SLEEP

fom Rarkay
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HANDIGE
GEREEDSCHAPPEN
EN FUNCTIES

Veel gereedschappen in
Photoshop zijn in alle Adobe-
software gekopieerd,
bijvoorbeeld Selectie, Lasso
en Tekengereedschap. Hier
zijn er vier die uniek zijn voor
lllustrator.

DEEL 2

PRAKTIJK

MODULE 5

GEREEDSCHAPPEN EN TECHNOLOGIEEN

BLOK 4

lMustrator

Adobe lllustrator is een programma voor het maken

van vectorafbeeldingen en wordt gebruikt voor het ontwerpen
van illustraties, logo’s en paginalay-outs. Je kunt hietin vormen
creéren en tekst bewerken. Qua omgang met lijnen vult lllustrator
het op pixels gebaseerde format van Photoshop aan.

£ Handig programma
lllustrator is een program-
ma dat op basis van vec-
toren werkt, Hiermee
kunnen ontwerpen en
aangepaste typografie
worden gemaakt en veel
verschillende technieken
toegepast, zoals op dit
krachtige affiche Felucia
Exotic Jungle Planet.

1 Pen (P) Maakt
vectorgebaseerde lijnen

2 Tekst (T) Voor typografis-
che oplossingen in het beste
programma voor logo’s en
dergelijke.

3 Rechthoek (M) voor
verschillende vormen.

Het grootste voordeel van lllusirator is dat je afbeeldingen
kunt herschalen zonder details te verliezen, door de ‘punt
en liin'-functie. Bijvoorbeeld: in een rasterafbeelding op
billboardformaat ga je de pixels wel heel erg duidelijk zien,
terwijl een vectorafbeelding zijn ontwerp behoudt door de
hoekmeetkunde en verhouding. Voor de grafisch ontwer-
per is llustrator een fijn programma. Een pad kan makke-
lijk worden versleept, bewerkt en opnieuw ingekleurd. Nef
als in Photoshop kun je werken met fransparante e
getextureerde lagen en typografie. Het eindresultaat is
geschikt voor dip. lllustrator heeft nog meer interessante
functies, zoals teksthewerking in een beeld, overtrekken
en bestanden maken voor CAD (lasersnijden/graveren,
vinyl, enz.).

4 Vervormen (Shift + R)
Verandert de geometrie van

vectorobjecten. Vervormen:
versleept een bepaald deel van
een object. Kronkel: verandert
de lokale geometrie/kleur in
een spiraal. Kristalliseer:
verandert de lokale geometrie/
kleur in gleufjes.

5 Mesh Tool (U) Creéert
kleurgradaties in een
tweedimensionaal
vectorvoorwerp. Maak
bijvoorbeeld een ster met
Ster. Als je dan in de vorm
klikt met de Mesh Tool
verschijnt er een hellinkje dat
je kunt bewerken.

Selectie-

gereedschap [— y

Pen

Werkveld

Het hoofdmenu voor
gereedschap bevindt zich
links, het canvas in het
midden, en de secundaire
gereedschapsbalken rechts.

#: Hoofdmenu
gereedschap Deze
gereedschapsbalk lijkt
erg op die in Photoshop.
Het grootste verschil

zit hem in de
gereedschappen

die hieronder zijn
beschreven.

Vulling en lijn. Door op
de vierkanten te klikken,
wissel je van
gereedschap. Dit kan
ook met X'

& Vlak ontwerp lilustrator biedt
een platform voor vlak ontwerp, met een
reeks minimalistische stilistische
elementen voor een driedimensionale
uitstraling (zoals gebruik van vectoren,
schaduwen, gradiénten en texturen). Dit
is vooral nuttig bij het ontwerpen van
websites en apps aangezien ze sneller
werken en minder geheugen gebruiken.

Direct
selecteren

Toverstaf en
Lasso

Gereedschappen Werkbalk

BY ATMOSPHERIC

THE FLUTTERING OF A BUTTERFLY’S WING IN RIO DE JANEIRO,

Pathfinder Met deze menu's kun je eenvoudige
vormen veranderen in complexere door delen samen
te voegen, te overlappen en weg te halen,

x

Transform Align Pathfinder
Shape Modes:

B P
Pathfinders:

T A W

BLOK 4: ILLUSTRATOR 115

Paletten, waaronde)
stalen en lagen

Uitlijnen Hiermee kun je geselectesrde
objecten uitlijnen. Ook kun je naar eigen inzicht
ruimte tussen voorwerpen toevoegen,

Transform ¢Align Pathfinder

Align Objects:
LI
Distribute Objects;

E e 1] S R

! Bestandsoorten

Er zijn drie hoofdtypes: pdf (Portable
Document Format), EPS (Encapsulated
PostScript) en Al (Adobe lllustrator Artwork).
Over het algemeen wordt pdf gebruikt voor
de eindresultaten die naar de drukker of
opdrachtgever moeten, EPS en Al zijn
bestandsoorten die intern worden gebruikt,

) CMYK

lllustratordocumenten moeten eerst in CMYK
worden omgezet, ter voorbereiding op wat
aan de drukker wordt geleverd.
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@ De Bézierkromme in
llustrator. Aan weerszijden zie
je ankerpunten en handvatten
(rechte, blauwe lijnen) die de
kromme bepalen,

Vectoren

Bézierkrommen zijn wiskundig bepaalde paden of vecto-
ren die tussen punten zijn gemaakt en aan weerszijden
met handvatten gemanipuleerd kunnen worden. Deze
curves, die Pierre Bézier in 1962 creéerde aan de hand
van Paul de Casteljaus algoritmes, zijin de steunpilaar van
voorwerpen die in lllustrator worden gemaakt. Je komt ze
ook tegen in de Adobeprogramma's als paden, gecreéerd
met de Pen, lijnen, voorwerpen en letterrichtlijnen in
InDesign. Daarnaast vormen ze de basis voor de digitale
letters die worden gebruikt in publicaties, tekstverwer-
kingsprogramma en 3D-softwareprogramma’s. Je kunt
een letter bewerken door met je Selectietool de bounding
box te kiezen; klik type en maak een omlijning. Zo worden
de letters vectoren met zichtbare paden en ankerpunten.

Precisiewerk

Precieze aanpassingen en gemakkelijk vergroten of
verkleinen zijn perfect voor het ontwerpen van typogra-
fische of picturale logo's. Vector.eps-afbeeldingen
worden gebruikt omdat ze kunnen worden vergroot tot
billboardformaat of worden verkleind tot visitekaartjes-
formaat zonder dat details verloren gaan. Het aanpas-
sen van de typografie moet altijd in IMustrator
plaatsvinden, omdat de resolutie hierbij niet verandert.

@ Ankerpunten en handvatten in lllustrator zijn
gebaseerd op mathematische algoritmes, niet op pixels.
Dat betekent dat een kleine tekening in lllustrator tot
elk gewenst formaat kan worden vergroot zonder aan
kwaliteit in te boeten. Dat maakt dit soort ontwerpen
zeer veelzijdig: dit ontwerp voor Team Romania is
toegepast in een scala een kleuren en uitingen.

@ Mogelijkheden Losse elementen zijn te
gebruiken in veel ontwerpen en diverse media. Ze
zijn uit te rekken, kunnen worden herhaald en naar
wens worden gebruikt op allerlei manieren, inclusief
opvallende plaatsing en kleurgebruik voor diverse
doeleinden.

Ankerpunt: een punt op of aan het eind
van een {kromme) lijn die de cursor kan
‘vasthouden’ en over het canvas kan
verplaatsen, hetzij om de lijn een andere
vorm te geven, hetzij om de hele lijn te
verplaatsen.

Canvas: net als in Photoshop is dit de
virtuele ondergrond waarop afbeeldingen
worden gelegd.

Handvat: ankerpunten die met
divergerende lijnen zijn verbonden aan
het belangrijkste vectorpad, De lijnen
kunnen worden gemanipuleerd om de
vorm van de curve te wijzigen,

Pad: een lijn die wiskundig is
vastgesteld. Dit heet ook wel een vector.
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Toepassen van Hlustrator Deze foto's tonen hoe
veelziidig en bruikbaar lllustrator in combinatie met
andere programma's kan zijn bij het vormgeven van
een huisstijl, in drukwerk, digitaal en op grote
schaal, steeds van messcherpe kwaliteit,
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MODULE 5

GEREEDSCHAPPEN EN TECHNOLOGIEEN

BLOK 5

Flash en After Effects

Adobe Animate en Adobe After Effects zijn twee van
de voornaamste softwarepakketten voor het maken van bewegende
presentaties. Beide creéren ‘bewegende beelden’ op een scherm of
website, beide gebruiken tijdlijnen en frames, en naar wens pixel- en
vectorafbeeldingen. Ze verschillen in hoe het materiaal wordt gerenderd
in het programma en hoe het aan het publiek wordt gepresenteerd.

Animate

Animate, voorheen bekend onder de naam Flash, hlinkt uit
in vectorafbeeldingen en wordt gebruikt voor interactieve,
op het web gebaseerde toepassingen en animaties, met
allerlei extra functies. Animate maakt gebruik van Action
Scripting, waardoor de functionaliteit en interactiviteit
aanzienlijk worden vergroot.

- Afbeeldingen uit lllustrator kunnen worden geimporteerd
en bewerkt fot animaties, of gecreéerd worden in het
ontwerpstadium en vervolgens gebruikt in praklisch elk
formaat (bijvoorbeeld SVG, PNG/JPEG sequence, FXG
graphic interchange format, QuickTime movie en animated
GIF).

« Complexe animaties worden beweging voor beweging
gemaakt met behulp van (key)frames. De overgang tussen
twee frames vindt plaats door ‘tweening. Hoe meer frames
per seconde (bijvoorbeeld 24fps, 25fps en 30fps), hoe
vioeiender de overgang. Anders dan bij After Effects

NUTTIGE GEREEDSCHAPPEN
EN FUNCTIES

De Animate-interface is op dezelfde
manier opgezet als de meeste Adobe-
software. De interface van After Effects
lijkt minder op de rest van Adobe, en
wordt gebruikt voor films. Hiernaast
staan enkele gereedschappen en
technieken die in beide programma’s
opvallen.

1 Animate: Bone Tool
De Bone Tool kan worden gebruikt

gebruikt voor tegenovergestelde kinematica
(IK). Met andere woorden, ze kunnen
worden gebruikt om met armaturen
verscheidene elementen op het canvas te
linken, zodat de beweging van het ene
element wordt doorgegeven aan het andere.

moeten overgangen tussen verschillende scénes of
vormen met de hand worden ingebouwd.

- Animate ondersteunt ActionScript, een objectoriented
programming (OOP) programmeertaal voor het interactief
maken van animaties.

« Er zijn opensource programmabibliotheken om de
gewenste vormen samen te stellen. Animate wordt veel
gebruikt op internet in de vorm van animaties, navigatie en
filmpjes, mede vanwege het bescheiden formaat. En
anders dan Flash omvat Animate HTMLS Canvas en
WebG L-support voor gebruik op web.

After Effects

After Effects maakt gebruik van vector- en
rasterafbeeldingen, van stilstaande beelden of filmpjes
afkomstig van Photoshop, llustrator filmcamera's of
animatiepakketten. Het wordt vooral gebruikt als

2 Animate: Packaging
Vergelijkbaar met de package
file-optie van InDesign is je bij
Animate de optie OAM
packaging, een comprimerend
zip-formaat waarmee je je
materiaal kunt importeren naar
andere Adobe tools, zoals
Muse of Dreamweaver.

Clip: naam voor een reeks
beelden of stukjes ontwikkelde
video of film.

HTML5 Canvas: De HTML
<canvas> container wordt
gebruikt voor computergraphics
met scripting {meestal
JavaScript).

Frame: frame van een animatie
in een belangrijke fase, of een
frame in een laag, compositie of
clip waar een overgang begint.
{After Effects gebruikt de
volgende Spatial Interpolation
key-frames; Linear, Auto Bezier,
Continuous Bezier, Bezier en
Hold).

SWF: ‘Small Web Format’, een
ongecomprimeerd en publicabel
bestandsformaat waarmee je
Animate-content kunt gebruiken
in een andere functie,
bijvoorbeeld Dreamweaver.
Tijdlijn: lineaire tijdlijn in
Animate en After Effects,
waarin frames kunnen worden
gemaakt om zo specifieke
bewerkte momenten in een
productie aan te wijzen.

WebGL: Web Graphics Library
wordt gebruikt voor interactieve
2D- en 3D-computergraphics
zonder gebruik van speciale
plug-ins.

3 After Effects: Cartoon
Effect Creder een cartoon die
lijkt op A Scanner Darkly en
andere rotoscoopfilms.
Importeer het live-materiaal in
de werkomgeving, ga naar het
menu Effects and Presets en
selecteer Cartoon. Het tweak-
en van de voorinstellingen en
het gebruik van de Blur-opties
egaliseert de kleuren, haalt
iets van de details weg en
zorgt voor een cartooneffect.

Het voarnaamste gereedschap: op dit
menu staal het gereedschap dat je elke
dag nodig hebt.

De audio-icoon
geeft de
aanwezigheid van
audio in de tijdlijn
aan.

@ Deconstructed Circle
Het storyboard toont de
reeks keyframes voor de
uiteindelijke animatie.
Deconstructed Circle is
gemaakt door Zak Peric in
After Effects en deze
animatie is te zien via de
weblink https://vimeo.
com/85708559.

» Puppet Pin Tool

uppet Qverlap Tool

"'E, Puppet Stacch Tool

4 After Effects: Puppet
Tool Perfect voor het maken
van een bone-structuur in
bitmap-beelden. Kies Puppet
Tool en maak markeerpunten
in de gewenste volgorde. Elk
markeerpunt kan apart worden
bewogen, zodat je complexe
bewegingen krijgt.

compositiegereedschap en om effecten aan te brengen in
de nabewerking. Als autonoom preduct voor viewing
(mpeg or gt [QuickTime] fileformats) worden clips en
stilstaande beelden op sporen gezet die lijken op
audiobewerkingsprogramma's, Overgangen en uitfaden
kunnen worden versleept en geplaatst tussen tracks en
vervolgens automatisch gerenderd worden met behulp van
computer RAM Memory (meer RAM-geheugen betekent
meer snelheid). After Effects bevat ook veel filters, effects

Composition Workspace is een van de "9
voornaamste panelen in After Effects: hier zie
je de voortgang van je werk,

@ I BDA@E D40 s @ i LU TN

Het Character-
paneel wordt
gebruikt om tekst
te bewerken, After
Effects kent veel
panelen, te vinden
in het Window-
menu,

Lagen worden
gebruikt om het
werkveld te
ordenen. Met
een kleurcode
zijn lagen in After
Effects
gemakkelijk te
organiseren.

Aud.io: hoe hoger de lijntjes, hoe sterker het volume in de
aud!o; lange verticale lijntjes duiden op sterk geluid, korte
verticale lijnen op zacht geluid.

en presets, zoals fimscratches of wazen, om een project
een bepaalde sfeer te geven. After Effects is vooral heel
populair en bruikbaar vanwege de vele externe plug-ins die
de functionaliteit verbeteren (Red Giant Trapcode Suite en
Boris FX Boris Continuum Complete). De AE Scripts
website (http://aescripts.com) is volgens velen de meest
complete vindplaats van gangbare plug-ins voor After
Effects en andere animatie, composities en 3D.

Ciose Panal
5 After Effects: Mocha Met deze autonome 6 After Effects: Animation mmmam I
functie van After Effects kun je bewegende Presets Menu After Effects: Sav Aation Prosat. T e
objecten in een film volgen, zodat woorden, Animation Presets Menu Likiedcnd By
afbeeldingen of symbolen aan de film Ideaal voor starters in de i mm A= U S
gekoppeld kunnen worden, zelfs als het een wereld van animatie en Nonebatal :
snelle of vage film is. Je kunt bijvoorbeeld compositie: After Effects e e oume Rafe
verschillende billboardafbeeldingen op een bevat voor-geanimeerde jmmm“ Imaae = 5
billboard plaatsen terwijl een auto passeert en presets die je in elk project ;;‘.'i:,_;;':‘ ""’;;J“ -

rasn

de camera draait om de auto te volgens (ofwel
four corner pin-methode).

effecten,

kunt toepassen. Deze
instellingen zijn zeer flexibel:
elk preset-frame kan worden
veranderd voor nieuwe

Shapes
Souind
Syntheucs
Téat
Transform
Transitions = Dissclves

Transitions = Movement

MY .Y ¥y W VX YUY YT

Transitians = Wipes
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Dubbelklik A-Master op de Pages-tab,
£ je stelt dan een sjabloon in dat zich door
]'j het hele document uitstrekt, Je kunt de

elementen in je document losmaken
voor wissen of bewerken, klik hiervoor
command-+shift.

MODULE 5: OPDRACHTEN

Door het instellen van marges en
kolommen zorg je dat alle tekst en
beelden behouden blijven tijdens het
drukproces en dat de pagina's door het

© SELECTIETOOLS IN PHOTOSHOP © FOTOMONTAGE IN PHOTOSHOP

' i Iden altijd ordelijk op te 5
g e T De lagen in Photoshop zijn als gestapelde

slaan voor later gebruik. Of je er nu afdrukken van

© BEELDBIBLIOTHEKEN

Gebruik alleen een stockfoto als je zelf geen foto
hebt. Hoe ingewikkeld het ook wordt, zie het
gewoon als een creatief probleem dat moet
worden opgelost. Maak zelf een foto van een
scéne, of maak verschillende foto's en vorm
hiervan een beeld met behulp van Photoshop.

Teken vier vierkanten in je schetsboek.

1 Zoek een beeldbibliotheek op internet of knip
een foto uit een tijdschrift, bijvoorbeeld een
berglandschap of een keukeninterieur. Maak een
afdruk (een demonstratieversie is heel geschikt
voor deze opdracht), knip hem op maat van het
vierkant en plak hem in. Dit wordt het
referentiepunt voor de andere vierkanten.

2 Maak een bijpassend stilleven met materialen
om je heen en een verrassende achtergrond of
omlijsting. In het thema oorlogsfoto kun je
bijvoorbeeld een soldatenschoen in de modder
fotograferen. Ben je tevreden met de setting, zorg
dan voor goede belichting en maak een foto. Print
hem en plak hem in het tweede vierkant.

3 Maak in het derde vierkant een collage en knip
of scheur hiervoor stukken uit een aantal eerdere
beelden (bijvoorbeeld foto's uit tijdschriften, eigen
foto's, tekeningen, textiel, advertenties,
verpakkingsmateriaal); rangschik ze tot een
origineel nieuw beeld, aansluitend op je gekozen
stockfoto.

4 Ben je handig met lilustrator, maak dan een
reeks vectorlagen om het tafereel op te bouwen.
Je kunt ook gewoon glad of getextureerd papier
gebruiken. Maak een afdruk en plak hem in het
vierde vierkant,

5 Maak tot slot een tekening in het vijfde
vierkant. Je mag zelf beslissen welke tools je
gebruikt. Door vaak te oefenen met tekenen heb
je altijd een plan B achter de hand voor beelden
in je projecten.

maakt of ze alleen op je computer opslaat, Met
een eigen beeldbibliotheek krijg je meer ideeén
en mogelijkheden voor nieuwe beelden. Zorg dat
je altijd een digitale of filmcamera bij je hebt, of je
smartphone, zodat je snelle snapshots kunt
nemen van inspirerende beelden die je later kunt
gebruiken.

© STARTEN MET PHOTOSHOP

1 Als je Photoshop opent, krijg je diverse
prompis om een nieuwe documentpagina te
openen; of kies File > New en geef het gewenste
paginaformaat aan.

2 Wil je een bestaand beeld wijzigen, kies dan
File > Open [je beeld].

3 Bedenk van tevoren voor welk doel je beeld
gebruikt wordl. Is dat nog niet duidelijk, kies dan
voor een hoge resolutie, aangezien je die altijd
gemalkkelijk kunt verlagen, terwijl verhogen vaak
gepaard gaat met kwaliteitsverlies. Kies Image >
Image Size > Resize to 300p/inch (niet cm).

Noot: p staat voor pixel (afgeleid van de term
picture element); het is de basiseenheid van
programmeerbare kleur op een digilaal beeld.

4 Als je al weet dat je werk op scherm of in druk
zal verschijnen, is dat eveneens van invioed op de
kieurinstelling (Color Mode). Kies Image > Mode
> RGB (scherm), CMYK (druk), Grayscale, Mono/
Duotone (zet je beeld eerst op Grayscale, daarna
krijg je de optie Mono/Duotone).

Noot: De specifieke kleur van een pixel is
opgebouwd uit rood, groen en blauw voor het
schermformaat RGB. Drukkers mengen kileuren
met cyaan, magenta, geel en zwart, ofwel CMYK.
Het resultaat ziet er anders uit op het scherm dan
in druk.

transparante plastic vellen. Je kunl door de
transparante delen van de laag de lagen ‘er_ondar
zien. Als je een laag aanbrengt, komt de inhoud
van de laag in de ‘stapel’ terechl. Als je een laag
deels ondoorschijnend maakt, wordt de hele
stapel minder transparant.

De selectiegereedschappen (Quick Selection,
Magic Wand, Marquee/Lasso, Magnetic Lasso
enz) isoleren een of meer delen van je beeld.
Door het selecteren van specifieke delen kun je je
beeld bewerken en effecten of filters toepassen
op delen van je beeld, terwijl de rest van het beeld
gehandhaafd blijit

Je kunt ook selecteren op basis van de kleuren in
een beeld. Kies > Color Range > selecteer met
de Eyedropper Tool de kleur van je keuze en
verhoog of verlaag dan de instellingen in de
kleuren. Naast pixels kun je ook vectoren
gebruiken voor selecties. Gebruik de Pen of
Shape Tools voor nauwkeurige omlijningen ofwel
paden. Paden kunnen worden omgezet in
selecties. Na voltooling van je laag of selectie heb
je een geisoleerd gebied dat je kunt kopiéren,
verplaatsen of verder bewerken. Experimenteer
met de instellingen hue/saturation, opacity/
brightness en contrast, enz.

Kies een foto om te experimenteren met dit
gereedschap. Sla na gebruik van elk gereedschap
een nieuw beeld van je foto op. Print na
experimenteren met minstens zes soorten }
gereedschap de bewerkte foto en noteer hierbij
wat je hebt gedaan en hoe elk gereedschap het
beste kan worden toegepast. Vind je sommige
soorten gereedschap makkelijker om mee te
werken dan andere? Wat gebeurt er als je de
basisinstellingen van deze gereedschappen
wijzigt?

Nu je weet hoe je een voorwerp kunt uitknippen of
delen ervan kunt bewerken, kun je nieuwe beelden
creéren door het combineren van elementen uit

verschillende foto's met allerlei beelden en texturen.

1 Kies drie tot vijf beelden uit je map of

stockbeelden. Kies drie tot vijf achtergronden en
texturen uit je mappen.

2 Open een nieuw Photoshop-document, Kijk
onder de optie File, kies Nieuw en maak een
document op Ad-formaat. Kies als resolutie
300dpi, zodat je het kunt printen, en noem het
bestand ‘Photomontage 1

3 Kijk onder de optie Lagen, kies Achtergrond en
verander dit in Laag O. Importeer een van je
achtergronden of texturen,

4 Maak paden op je onderwerpen of voorwerpen.
Knip en plak ze op een nieuwe achtergrond. Elke
komt binnen op zijn eigen laag. Met de Move tool
kun je al je geimporteerde voorwerpen verplaatsen
en vergroten zonder ze te vervormen.

£5 Maak drie fotomontages waarin onderwerpen en
voorwerpen in een nieuwe situatie worden
geplaatst, Experimenteer met filters om de kleur te
beinvioeden en plaats je onderwerpen zodanig dat
ze er zo realistisch mogelijk uitzien op hun nieuwe
plek. Let ook op de belichting van de voorgrond en
achtergrond en kijk of je die op elkaar kunt
afstemmen.

6 Is een bestand naar wens, sla het dan op
inclusief alle lagen. Daarna kun je het beeld flatten
en bijsnijden. Gebruik Opslaan als, geef je bestand
€en nieuwe naam en sla de gecomprimeerde
versie onder een andere naam op. Deze is Kleiner
en gemakkelijker te importeren. Bewaar altijd de
originele gelaagde versie voor het geval dat je een
wijziging wilt aanbrengen.

| SI——C XN hele document heen dezelfde

leesbaarheid ten goede.

Q PAGINA SAMENSTELLEN IN INDESIGN

Bij deze opdracht maak je met InDesign een

boekje en doe je gaandeweq de basiskennis van
dit programma. op.

1 Bestandsbeheer

Onthoud vooral dat InDesign zelf geen informatie
omvat maar links vormt naar een externe bron.
Zodra je de oorspronkelijke file verwijdert of een
nieuwe naam geeft, is de link met InDesign
verbroken en verdwijnt het gewenste materiaal uit
je InDesign-document. Het is dus raadzaam een
goed systeem voor file-management op te zetten,
Maak een map met de titel ‘InDesign opdracht! sla
hierin het InDesign-bestand op en maak kleinere
folders voor tekst en beelden.

2 Korte samenvatting

Lees online-informatie over het programma
InDesign. Wat houdt het in? Waarvoor wordt het
gebruikt? Vat wat je te weten bent gekomen
samen in een uittreksel van 250 woorden, Deze
tekst zul je misschien nog aanpassen naarmate je
meer inzicht krijgt in het programma. Sla de tekst
op als Word-document (WORD.docx) binnen de
tekstmap. Kies tevens een foto van internet, of
een folo, of maak een gescande tekening van
eigen hand, passend blj jouw idee&n over het
programma. Sla dit op in de beeldmap.

3 Start

Open InDesign en kies File > New > Document
(command+n). Stel in het pop-upvenster je
document in op 140 mm x 200 mm door deze
waarden in te vullen en kies met het icoon voor
staande pagina's. Klik Facing Pages aan, daarmee
maak je spreads voor een brochure of boek in
plaats van losse pagina's. Kies 4 als aantal

tot zijn recht doet komen.

pagina's. Je kunt hier als je wilt ook kolommen en
marges instellen, maar daar is ook een andere
optie voor als je in het programma werkt,

Kies je More Options, dan zie je ruimte voor het
instellen van de afloop. Deze instelling maak je
met het oog op de drukker, die hier de pagina's
zal afsnijden, De standaard is 3-5 mm, maar
overleg dit eerst met je drukker. Voeg de waarde
in en klik op OK.

4 Master pages

Nu ga je werken in het programma en zie je het
blanca document voor je. Het wordt nu tijd om na
te denken over een framework. Kies Pages op het
menu rechtsboven (is dit niet te zien, ga dan naar
Window > Workspace > Essentials; mogelijk moet
je Essentials ‘resetten’ als je een openbare
computer gebruikt). Nu verschijnt de Master page
bovenaan. Alles wat je instelt op de Master page
of spread zal worden ingevoegd in het hele
InDesign-document.

Dubbelklik om te beginnen op beide pagina's op de
spread. Het is belangrijk dat alles wat je verandert
van toepassing is op beide pagina's van de spread.

Layout > Margins and Columns > Stel je marges
in op 10 mm, behalve de onderste marge, die je
instelt op 15 mm. Mogelijk moet je voor het
invoegen van de verschillende waarden tweemaal
klikken op het lock-icoon.

Layout > Create Guides > Hier kun je de
kolommen instellen. Stel 3 rijen en 4 kolommen in
tot aan de marges. Klik op OK.

basisstructuur hebben. In documenten
met veel tekst zijn marges aan de
onderkant meestal groter, dat komt de

= | De Guides kunnen worden ingesteld
voor een evenwichtige structuur op de
pagina. Bedenk van tevoren wat voor
informatie je pagina's moeten bevatten
en ontwikkel een systeem dat de inhoud
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MODULE 5: OPDRACHTEN (VERVOLG)

5 Tekst invoegen

Nu je basisstructuur klaar is, voeg je je tekst van
9250 woorden in op een spread. Kies in de
menubalk T (Type Tool) en teken een tekstblok
dat past in een van je kolommen. Importeer je
tekst met File > Place en klik het Word-
document aan. Het verschijnt nu in het tekstblok,
maar past er misschien niet helemaal in. Als de
tekst eruit valt, verschijnt er een rood plusje (+) in
de hoek rechtsonder van het tekstblok. Klik met
de Selection Tool op dit symbool en maakt een
nieuw tekstblok op je pagina. De tekst loopt nu
door van het ene tekstblok naar het andere. Een
dun blauw lijntje geeft de verbinding tussen beide
tekstblokken aan.

Je kunt nu het lettertype, het formaat en de
plaatsing aanpassen, zie hiervoor Window >
Workspace > Typography. Verander de letters
minstens eenmaal, zodat je het verschil in uiterlijk
en het aantal woorden per regel ziet. Voeg een
kop en zo nodig tussenkopjes toe. Type een titel
voor de tekst en bedenk hiervoor een lettertype
dat de oorspronkelijke tekst aanvult. Hoe werken
deze vier elementen op elkaar in? Heb je
negatieve ruimte over? Heb je beide pagina's
gebruikt op een interessante manier, zodat ze
goed met elkaar in evenwicht zijn?

6 Beelden invoegen

Voeg nu een beeld in. Kies File > Place en plaats
het beeld in het stramien. Of maak een beeld en
kies terwijl het geselecteerd is File > Place: het
beeld vult dan de vorm. Gebruik Control + Click >
Fitting of de Direct Selection Tool om te
experimenteren met de manier waarop het beeld
de vorm vult, Wil je de Kkleur in je foto veranderen,
ga dan naar Photoshop en verander deze, waarna
je het bestand opslaat op dezelfde plaats met
dezelfde naam, zodat het automatisch wordt
geiipdatet. Bij twijfel kun je het beeld het beste
vervangen.

7 Persoonlijke touch

Je beheerst nu de basisstappen van dit
programma. Experimenteer verder met de kleur
van het document met verschillende tools. Voeg
een voorkant en een achterkant in, Kun je nog

meer foto's invoegen? Of iets spannends doen
met de typografie? Op een computer ontwerpen
is altijd moeilijk, dus neem even afstand en werk
in je schetsboek. Bedenk welke boodschap je wilt
overbrengen, en aan wie. Wat vind je van
InDesign? Zou je je ontworpen boekje kunnen
omzetten in een handige gebruiksaanwijzing?
Maak een paar schetsen voor de opmaak en pas
ze toe in je ontwerp.

© VECTORLETTERS

Voor deze opdracht ga je in lllustrator een vector-
lettervorm bewerken en een hele nieuwe letter
tekenen.

1 Kies de Type Tool en typ een letter naar keuze
in een lettertype naar keuze.

2 Selecteer het tekstblok met de Direct Selection
Tool en klik Type > Create Outlines. litustrator
heeft je lettervorm nu omgezet in een vectorvorm.
Deze techniek wordt vaak toegepast bij
vinylbedrukking of screen prints. Zorg dat je een
niet-omlijnde versie bij de hand houdt voor het
geval dat je de letter wilt bijwerken.

3 Als je de Direct Selection Tool gebruikt, zie je
dat de lettervorm nu hendels heeft gekregen. Pak
de hendels vast en draai eraan, dan zie je hoe de
lettervorm verandert.

4 Gebruik de verschillende opties van de Pen
Tool om hendels toe te voegen of te verwijderen
en verwijder kromme lijnen of voeg ze toe.

5 Houd de leesbaarheid van de letter voor ogen
maar bewerk hem tot een abstracte vorm.

6 Teken naast de uiteindelijke abstracte letter
met de Pen Tool de losse vorm die je hebt
gemaakt. Gaat dit moeilijk? Is er een makkelijke
methode? Kun je gebruikmaken van bestaande
vormen? Of een stramien? Experimenteer
hiermee.

O EEN BLAD TEKENEN MET
ILLUSTRATOR

1 Kies de Arc Tool en trek vier lijnties zoals hieronder
aangegeven. Zorg dat de buitenljntjes van het blad,
de binnenlijnties van het steeltje en de bladpunt net-
jes samenkomen. Gebruik de White Selection-pijl om
de ankerpunten op hun plaats te zetten en de hen-
dels van de lijntjes te hanteren.

2 Selecteer de lijntjes door Shift ingedrukt te houden
en elke aan te klikken met de Black Selection-tool.
Kleur de lijntjes groen of C80 M15 Y100 K.
Selecteer dan de bovenste lijn en kieur hem geel of
C5 MO Y100 KO. Selecteer ten slotte de onderste lijn
en kleur hem roestbruin of C40 M70 Y85 K35.

3 Selecteer de onderste twee lijnties met de Black
Selection-pijl. Ga naar Object > Blend > Blend
Options, kies de optie Smooth Color en dan OK. Druk
dan op Alt + B en (Mac) of ctrl (PC). De onderste
helft van het blad wordt nu gekleurd.

4 Selecteer de bovenste twee lijntjes en herhaal stap
3. Het hele blad is nu gekleurd. Selecteer ten slotte
beide helften van het blad en ga naar Object >
Group. Het blad is nu een geheel.

|

© ANIMATIEVORMEN MET AFTER
EFFECTS ANIMATION PRESETS

Set: Zak Peric

In deze opdracht maak je een animatie van drie
seconden met behulp van de presets in After
Effects.

1 Kies van het Composition-menu New
Composition. Kies van het Preset drop-downmenu
HDV/HDTV 720, 29.97. Stel de tijd van de
animatie in op een duur van 0;00;03;00 (3
seconden). (zie afb. 1)

2 Zoek het menu Effects and Presets (rechts op
het scherm) en open Animation Presets > Locate
Shapes-folder > Sprites-Still > Fan Blades-presst,

Sleep met je muis Fan Blades naar je compositie,
(zie afb. 2)

3 Ga terug naar Effects and Presets, zoek nu de
map Behaviors en klik op het driehoekje
(disclosure triangle) om het menu te openen.
Zoek nu de preset genaamd Rotate Over Time.
Sleep deze preset naar Shape Layer 1 op je
tijdlijn. Test de animatie door enter in te typen op
je toetsenbord. (Met de entertoets op je
toetsenbord speel of sluit je de animatie af).

4 Nu ga je de snelheid van de animatie
aanpassen. Zoek in het paneel Effects Controls
(linksboven op het scherm) Rotate Over Time-
effect en verander de rotatie van Ox+10.0 naar

Ox+l80.0. Test de snelheidsverandering door
opnieuw enter te typen op je toetsenbord; de
bloem draait nu sneller. (zie afb. 3)

S Ga opnieuw naar Effects and Presets en zoek
Behaviors > Fade In+Qut—Frames. Sleep deze
preset naar Shape Layer 1. Zet de Current Time
Indicator in het voornaamste ftijdlijnvenster op 0
frames. De bloem is nu verdwenen: je hebt met
succes fade in/fade out toegepast. Test je

animatie opnieuw door enter in te drukken. (zie
afb. 4)

6 Nu ga je een QuickTime-filmpje maken, Ga
naar File > Export > Export to Render Queue. Je
Ziet nu een nieuw Render Queue-venster met drie
gemarkeerde opties. (Render Settings: Best
Settings, Output Module: Lossless, en Output To:
Not Yet Specified). Klik op Not Yet Specified, dan
opent zich een nieuw zoekvenster, het bestand
krijgt de naam Comp1.mov. Breng de animatie
onder in een desktop- of documentenfolder en

Klik op Save. Zodra je Save indrukt, verdwijnt het
venster.

7 Voor het laatste onderdeel van deze oefening
klik je op de knop Render in het venster Render
Queue. Daarna zal het filmpje verschijnen in de

desktop- of documentenfolder, zoals aangegeven

in stap 6. Speel deze laatste render als test van je
animatie,
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